LAB 1 – Installing Appliances in GNS3 
In this lab you will download and install “Appliances” in GNS3. Appliances are the equivalent to devices, they consist of hosts (PCs), network equipment such as Routers, etc.. After importing the appliances into GNS3 in Part1, we will test them in Part 2 via some simple exercises to make sure that they are all working properly and can interoperate.

Part 1 has 4 (A-D) sections for appliance installation. Part 2 is on testing the functionality and interoperability of the installed appliances. Part 3 shows you how to download and use Wireshark within GNS3.


Part 1A. Importing and Installing Router Image in GNS3
1. First you will need to download the Cisco IOS image “c3640-a3js-mz.124-19b.bin’’ from the UCI-ICS masterhit network drive (network_lab directory, cisco folder). To do that you have to map the “UCI-ICS masterhit network drive” to your desktop.
2. Here are instructions on how to map a drive to your computer:
https://swiki.ics.uci.edu/doku.php/accounts:mapping_network_drive

A UCI VPN[footnoteRef:1] connection is necessary to access the UCI masterhit network drive. Once you are on "network_lab", go to folder "cisco" and copy the Cisco IOS image mentioned above (only one in folder) to your computer. NOTE: The following are not links to web pages they are locations to the network drives from which you download the software. [1:  If you don't have the VPN client, click UCI-VPN to download. You need to login with your UCI ID and password to activate the VPN. You also need an ICS account to download the s/w. if you are not an ICS student taking this class, you can go to the ICS tech support (ICS bldg) and they will give you a temp account for the quarter.] 


· Windows: \\masterhit.ics.uci.edu\network_lab
· Mac: smb://masterhit.ics.uci.edu/network_lab

3. Open the app GNS3 that you installed on your computer in Lab0. You should see a screen as shown below.
[image: ]
4. Note: Your VMWare Workstation (Windows) or Fusion (Mac) will fire up upon starting GNS3 and your GNS3 VM will start up and you will see the screen below. This will happen every time you start GNS3. Ignore this screen in the VMware Workstation tab. For VMware Fusion minimize the window. If it does not fire up, then quite GNS3. Start VMware, then click on GNS3VM to start that up. Once the GNSVM starts and you see the screen as shown below, you can start GNS3.
[image: ]
5. Go back to GNS3, and go to: 

Windows: Edit  Preferences
Mac: GNS3 -> Preferences

6. In the left-hand pane, click on the dropdown menu next to “Dynamips”, then click on the sub-menu “IOS routers” and click “New” as shown.
[image: ]

7. Select “Run this IOS router on my local computer” and Click “Next” as shown.
[image: ]
8. Then click on "Browse" to select the Cisco IOS image on your computer “c3640-a3js-mz.124-19b.bin’’. Click “Next”.
[image: ]
9. Click yes when you are prompted to decompress the IOS image.

10. Click “Next”. For “Name” type “c3640”, select the "Platform" as c3600 and "Chassis" as 3640 as shown below.

[image: ]

11. Click "Next" and check to see if memory size is set to 128MiB, if not, set it to that size. Please note that the memory size setting is strict, i.e., not optional. Setting memory to more than 128MiB can cause a problem when you are running large network configurations with several routers.

[image: ]
12. [bookmark: _Hlk13504620]Click "Next" to get to screen for "Network adapters" selection as shown below. Choose NM-1FE-TX from the dropdown menu for slot 0 through slot 3. 

[image: ]

13. Click “Next”. Find the Idle PC value by clicking on “Idle-PC finder” in screen below. Please note that you can skip this step if the Idle-PC finder fails more than a few times. Click “Finish.”
[image: ]

14. After finishing the setup, you should see the following screen. Click "Apply", then "OK".

[image: ]

15. In the console window that appears, click on "Browse All Devices" icon, (5th icon on the left-hand side shown in red rectangle)) in screen below and select “Installed appliances”, to browse all current GNS3 devices. Please note that if the c3640 does not appear in the installed appliances list quit GNS3, then reopen GNS3. The icon should appear.

[image: ]
16. Click on the “folder icon” in upper left-hand corner or choose “New blank project” from “File” menu.
[image: ]

17. From the devices list, click on c3640 and drag it into the project pane.
[image: ]

18. Right-click on R1 and choose "Start".
19. Right click on R1 again and select “Auto Idle-PC”. The system will choose the best value. If it fails try again until it succeeds.
20. Right-click on R1 and choose "Console". Console window will open. You may be prompted in console window to press "Return" key to get the prompt line.
21. You have finished the first step in running GNS3.
22. Stop all running devices by clicking the “Stop All Nodes” button (red square button on upper tool bar) in GNS3. Quit GNS3.

[image: ]
Part 1B. Importing ipterm into GNS3
1. First you will need to download the “ipterm” appliance from the GNS3 Market Place as shown below using the following link:

https://www.gns3.com/marketplace/appliances

[image: ]

[image: ]

2. [bookmark: _Hlk13516868]Open File menu and select Import appliance as shown.
[image: ]

3. For Windows: Select “ipterm.gns3a” file from your Downloads folder and click “Open”.
4. For Mac: Go to your Downloads folder and search for “ipterm.gns3a.txt”. Change the extension from “.gns3a.txt” to “.gns3a”[footnoteRef:2] (see footnote below). Then Select “ipterm.gns3a” and Click “Open”. [2:  Select the downloaded file and under File, choose “Get Info” and under “Name and Extension” delete “.txt”. Exit “Get Info”. You should now see the file without the “.txt” extension.] 

5. The following screens will appear. Click "Next" all the way through and click “Finish” and you will finally see the “ipterm installed” screen. Click “OK”. And you will see the GNS3 screen.

[image: ] [image: ]

[image: ] [image: ]

[image: ]

6. Go to “Preferences” under GNS3 and select “Docker Containers” as shown below.
[image: ] [image: ]

7. [bookmark: _Hlk13518521]Click on “Edit”, then for “Template name” change to “PC as shown below. Remove “-“ from “Default name format”.
[image: ]		[image: ]

8. You will see the following screen. Click “Apply” and “OK”. That will take you to the main GNS3 screen. When you click on the “Browse All Devices” icon, you should see “PC” now listed under Installed Appliances as shown.
[image: ] [image: ]

2. “ipterm” setup is now complete. Stop all running devices by clicking the “Stop All Nodes” button (red square button on upper tool bar) in GNS3. Quit GNS3.
Part 1C. Importing Lubuntu VMs Alice, Bob and Mallory into GNS3
1. Open “Preferences” in GNS3.
[image: ]
2. Click VMWare VMs under the VMware tab. Click “New”.
[image: ]
3. Select “Run this VMware VM on my local computer”. Click “Next”.
[image: ]
4. Choose Alice from “VM list”. Click “Finish”.
[image: ]
5. You will see the following screen. Click “New” and repeat for Bob. 
[image: ] [image: ]

6. When done importing Bob, click “Apply”. Click “Finish”.
[image: ]

7. Then repeat the same process for Mallory as well. When done click “OK”.

8. You should have three VM templates in your GNS3 VM, Alice, Bob and Mallory which looks like the following.
[image: ]
9. Now you will change the Ethernet interface name of the three VMs. Under “Preferences” in GNS3 go to VMware select “VMware VMs”. You will see Alice, Bob and Mallory. Select the VM and Click “Edit”. You will see two tabs. Click on “Network” tab. For “Name Format” type “ens33” as shown below. 
10. In the same window you will check “Allow GNS3 to override non custom VMware adapter” as shown below. Click “OK”.
11. Then click “Apply” and “OK”.
[image: ]

12. Repeat for Bob and Mallory.

13. Import of Alice, Bob and Mallory into GNS3 is now done. You should see all three VMs under your “Installed Appliances” list.

[image: ]

14. Do not stop GNS3, go to Part 1D to finish your GNS3 setup. It is the last step to complete the appliance import part of this lab.




Part 1D. 	Blocking Local PC traffic to VM interfaces 
1. Under “Preferences” in GNS3 select VMware and the VMware preferences screen will be displayed. Click on the “Advanced local settings” tab. Click “Block network traffic originating from the host OS”. Then click “Configure”. When the configuration is done, click “Apply” then “OK”.

[image: ]

2. Click the red “Stop” button and Quit GNS3.

3. You are now done with all the imports for GNS3 and can start testing the devices in Part2.



Part 2. Testing imported Appliances in GNS3
In this part we test the interoperability of the PCs, Alice, Bob and Mallory. 

1. Open GNS3 and create a new blank project and name it “test”.

Note: In this section, we will have all three VMs running at the same time, it might consume a lot of processing power and slow down your laptop significantly. Please be patient when starting GNS3 up.
[image: ]

2. From the “Browse all devices” button on the left, drag one PC, Alice, Bob, and Mallory into your test project pane.

3. Use an Ethernet hub to connect the four hosts as shown in the figure below. For the Ethernet hub, from the dropdown menu, always select “GNS3 VM (GNS3 VM)” as the server as shown below. Use the link icon in the right pane to create the actual links between the devices.

[image: ] [image: ]





4. Once you have set up the configuration with the appliances you should see the following screen with red dots beside each appliance in the “Topology Summary” pane on the right:
[image: ]
5. Click the “Green Play” button as shown below to start the devices. After clicking Play, all the devices should start up, please be patient as it may take some time.
[image: ]
6. Note: For the PCs (ipterms) you will open a console window from within GNS3. Alice, Bob and Mallory do not open consoles in GNS3. They operate inside VMware as independent machines. They will open up their own console windows under VMware as regular workstations. Each VM will fire up a window when you click on the Green Play button. You will need to login into the VMs. Then open a “Terminal” as was demonstrated in Lab0. 

7. If the devices fire up correctly, you will see green dots instead of red dots in the upper right pane beside each device as shown below. Proceed to step 10.

[image: ]

8. If instead errors pop up as shown in the next few screens, follow these instructions to resolve. If these errors do not appear, go to step 9 below.
· If you see this error message pop up, click “OK”. The virtual machine should Power On after you click “OK”.
[image: ]
· Click “No” if you see this message pop up on a Windows Laptop. 
[image: ]

9. If you see an error in the GNS3 screen that says “Could not find NPF id for VMnet0” and/or you see that Alice, Bob or Mallory have not started - the dot beside the device has remained red in the upper right Topology Summary pane, you need to follow the instructions given below. If not, go to step 11.

 [image: ]
· Click the big red stop button in GNS3 to stop all the VMs from running.
· After all the VMs stopped…. Do:

For Mac:
· Go to VMware Fusion to set the Network Adapter.
· Right click anyone of the 3 VMs and choose Settings... 

[image: ]

· The Mac Settings window will open. Find the “Network Adapter” and click. 

[image: ]



· “Network Adapter” window will open. Select under Custom “vmnet2”.
· 
[image: ]
· Recall, you need to do this for each of “Alice” “Bob” and “Mallory”. 

For Windows:
· Go to VMware Workstation to set the Network Adapter.
· Right click Alice and choose “Virtual Machine Settings”. Select “VMnet2”. Click “OK”. Repeat for Bob and Mallory.
[bookmark: _GoBack][image: ]
10. When completing the network adapter steps, try starting all the VMs. They should fire up and all show green dots.

11. The Lubuntu VMs, Alice, Bob and Mallory will power on with a User screen showing your user name (here shown as Alice, note all three VMs will have same user name as the latter two are clones of Alice). To login, type your password, then open a Terminal window.
[image: ][image: ][image: ]

12. For the labs it is recommended that you switch to the root account for the Lubuntu VMs (Alice, Bob, Mallory). Makes it easier for configuring your VMs.
a. First setup a root password. At the prompt type: 
sudo passwd root
b. Then enter a New Unix password. Then Retype New Unix password to confirm. Use any password you like just make sure to remember it. You will see a message that says: Password updated successfully.
c. Then type at the prompt: 
su root
d. You will be asked for the root password.
e. You are now “root” on the VM.
f. The commands for Alice, Bob and Mallory below only work if you are “root”. If you neglected to switch to “root”, you will have to use “sudo” before every command you type. E.g., sudo ifconfig……. Some commands, such as “ping” do not require sudo. However, all configuration commands do, and you will be doing a lot of device configuration.
13. For the PCs (and in later labs the Routers), you need to open a console window. That is done by right clicking on the device and selecting “Console” from the menu. The console window will open for that device and now you can start to configure the device.

[image: ] [image: ]
14. Note: Before assigning an IP address to a VM, click on the network icon (highlighted in red rectangle below) on the bottom left to make sure there is no active connection to your VM. If “Wired connection 1” is showing in list as shown below, click on it , that will close it as shown in bottom screenshot. Wired connection 1 can sometimes cause your manually assigned IP address to be flushed out. Please do this every time you start GNS3 and fire up the VMs.
[image: ]  [image: ][image: ]
15. The prompt in the console for the Lubuntu hosts is “root@username-vm:/home/alice#:”. In the Lab documents we will use the prompt: Alice-1%, Bob-1% and Mallory-1% for simplicity.
16. The prompt in the console for the ipterms (PCs) is “root@PC1:~#”. In the Lab documents we will use the prompt: PC1% for simplicity.
17. To configure the PC you need to open a console window from within GNS3. Right click on the PC and select “Console” from the menu.
[image: ] [image: ]
18. When the console window opens, hit enter/return. It is now ready for your input.
19. Issue the following commands in the console/terminal windows for each of the devices to configure their IP interface[footnoteRef:3]. [3:  Note that the IP address is 32bits broken up into 4 8bit bytes separated by “.”.We refer to that notation as dotted decimal notation A.B.C.D where A-D can be 0-255. The “/24” refers to the subnet part of the address, this will all be explained in detail in Lab 3 class.] 


For PC1: PC1% ifconfig eth0 10.0.1.1/24
For Alice-1: Alice-1% ifconfig ens33 10.0.1.2/24
For Bob-1: Bob-1% ifconfig ens33 10.0.1.3/24
For Mallory-1: Mallory-1% ifconfig ens33 10.0.1.4/24

20. After configuring the interfaces, check to see if all is correct by typing type ifconfig in each of the console screens. You should see the following output for each device.
PC1:
[image: ]
Alice-1:
[image: ]
Bob-1:
[image: ]





Mallory-1:
[image: ]

21. After verifying the IP addresses of all the devices, issue a “ping” command from each device to the others as shown below[footnoteRef:4]. They should all be successful. If not there is an error in your configuration. Type the following commands at the prompt on each device: [4:  -c5 limits “ping” to 5 ping messages, ping without “-c#” will send pings continuously until halted/terminated by ^C.] 


a) For PC1: 
PC1% ping 10.0.1.2 -c 5
PC1% ping 10.0.1.3 -c 5
PC1% ping 10.0.1.4 -c 5
b) For Alice: 
Alice-1% ping 10.0.1.1 -c 5
Alice-1% ping 10.0.1.3 -c 5
Alice-1% ping 10.0.1.4 -c 5
c) For Bob:
Bob-1% ping 10.0.1.1 -c 5
Bob-1% ping 10.0.1.2 -c 5
Bob-1% ping 10.0.1.4 -c 5
d) For Mallory: 
Kali-1% ping 10.0.1.1 -c 5
Kali-1% ping 10.0.1.2 -c 5
Kali-1% ping 10.0.1.3 -c 5

22. Screenshot of a successful ping:
[image: ]
23. Return to the GNS3 window, stop all devices. NOTE: Wait until all the VMs show red in the right pane. Do not Quit GNS3 before all VMs have stopped. You do not need to save the project. All the VMs will show suspended state when stopped as shown below. 
24. Quit VMware.
[image: ]
[image: ]



Part 3. Downloading and Using Wireshark in GNS3
In this part, you will become familiar with Wireshark and its filter expressions.[footnoteRef:5] [5:  The filtering capabilities and options of Wireshark are described under the help tab in Wireshark.] 


Download the Wireshark software from here for Macs. It is pre-installed with GNS3 for Windows. If you have a problem, you can follow that same link to download the Windows version.

IMPORTANT NOTE: Whenever you STOP Wireshark Capture and start it again in the same GNS3 project, you HAVE to give the file a NEW NAME. If not, it can hang with the old file name and you won’t capture any traffic.

Part 3(A). Starting Wireshark
1. Open GNS3 and set up the project as shown below:

[image: ]

2. Start GNS3 using the green play button. Use the ifconfig command introduced in Part 2 to set up the PC IP addresses in their console windows.

PC1% ifconfig eth0 10.0.1.11/24
PC2% ifconfig eth0 10.0.1.12/24



3. Before you start using Wireshark:
a) For Windows: Make sure that the Packet Capture settings are set to Wireshark Live Traffic Capture from the "Packet Capture" tab under Edit/Preferences as shown below in Figure 2.2.

[image: C:\Users\localadmin\Google Drive\CSx33\packet_capture_settings.png]
Figure 2.2 Packet capture Preferences

b) For Mac: The packet capture entries should be set under Preferences in GNS3 as shown in Figure 2.3.
[image: ]
Figure 2.3 Mac OS Wireshark Settings

4. To start Wireshark Capture, right click[footnoteRef:6] on the link that connects PC1 and the Ethernet Hub and select “Start capture”. (If requested, choose option ETHERNET (only option available). Then right click on the icon and you will see "Start Wireshark”. The Wireshark Network Analyzer opens in a new window as shown below. [6:  Reminder: Right Click on MAC is two fingers tap on track pad.] 


[image: ]

5. In the console window of PC1, issue a ping command to PC2:

[bookmark: _Hlk14626918]PC1% ping 10.0.1.12 –c 5

6. Stop the capture process by clicking on the red stop button in the Wireshark window.

7. Saving captured traffic. You can save the capture as a ‘.pcap’ file by going to File -> Save. You can open this file for data analysis at any time by opening it in the Wireshark application.

Part 3(B) Setting display filters

Restart the Wireshark capture under a different name, and once again ping PC2 from PC1 as we did before.
Now we can add some filters in. Click in the “Apply a display filter…” field.

[image: ]

Type “ip” into the field. Notice how you have a list of options that begin with ip, all of which can be applied to the link between PC1 and the Ethernet Hub. For now select “ip.addr == 10.0.1.11” and press enter.

[image: ]

[image: ]

Now notice how you only see the IP packets to and from PC1. This is because you are only viewing packets coming in and out of PC1 who has the IP address “10.0.1.11” as their source or destination.
Now let’s try something else. Go back the apply filters bar and change “ip.addr == 10.0.1.11” to “ip.src == 10.0.1.11”. You should now see the following:

[image: ]

Now only the packets that have PC1’s IP address as the source, meaning the ones sent from PC1, are displayed in Wireshark.
Another way you can do this is by right-clicking one the IP packets in the source field with 10.0.1.11 as the source and selecting “Apply as Filter > Selected”.

[image: ]

Doing this in any of the fields will apply that as the filter. Selecting the source field will filter out any packets that weren’t sent from that IP, same applies for destination, time, and length.
Click the ‘X’ at the right end of the filters bar to get rid of any filters.
You can also apply multiple filters to a Wireshark capture. For example, select “Apply as Filter > Selected” in the Source field of the first line (MAC address of PC1), and then type in the bar the expression “&& arp”. This will show only ARP protocol packets from the MAC address of PC1 (you’ll notice before adding the second expression that it still shows ICMP protocol packets with the source IP “10.0.1.11”).

[image: ]
Before adding the ARP filter
[image: ]
After adding the ARP filter

If you have any programming or Boolean algebra background, you’ll notice this follows the Boolean logic format of AND (&&) and OR (||) functions to apply multiple filters. This means you can also filter out specific data types, using the NOT function, or the ‘!’ symbol, before typing a filter.

To get rid of any packets that the source IP is 10.0.1.11, clear out any current filters you have, and apply the “ip.src == 10.0.1.11” filter, but add an ‘!’ before it, so you have “!ip.src == 10.0.1.11” as a filter. You should see the following:

[image: ]

Note that this can also be done by right-clicking the source field and selecting “Apply as Filter > Not selected”, as well as the other Boolean operation options from that field.
So now that we’ve discussed what filters are and how to apply them, we will discuss how to save filters. Go to the plus sign (+) in the top right corner next to “Expression…” in the filter bar as shown below.

[image: ]

[image: ]

You can use this toolbar to save filters for future use in other projects. For example, in order to add the filter we applied in the beginning to see only PC1 traffic, ”ip.addr == 10.0.1.11”, type the expression in the “Filter” field, then type a name for it in the “Label” field, such as PC1.

[image: ]

Press OK to save the filter.

[image: ]

Notice how now there is a PC1 filter you can apply as shown above. Click it to apply it to this Wireshark Capture.

[image: ]

You can save multiple filters , which can consist of a combination of expressions, using AND and OR functions.
All saved filters will remain in Wireshark and will appear every time you start a capture.
Take note that you can only apply one saved filter at a time; however, you can take a saved filter, and add onto it once it is displayed in the filter bar, using the Boolean notation.
You can remove the PC1 filter and close Wireshark. No need to save the output. Stop and quit GNS3.
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Ipaddr == 192021 and not tcp.port in (80 25} Broadcast ARP 42 who has 10.0.1.12? Tell 10.0.1.11
ipv6.addr == 2001:db8::1 )
i0.addr == 192.0.2.1 fe:7a:ab:37:e7:4b ARP 42 10.0.1.12 is at be:@b:8c:f7:58:e6
iaddr:: 101 11 10.0.1.12 ICMP 98 Echo (ping) request 1id=0x@036, seq=1/256, ttl=64 (reply in 4)
ip 10.0.1.11 ICMP 98 Echo (ping) reply id=0x0036, seq=1/256, ttl=64 (request in 3)
ipaccess 10.0.1.12 ICMP 98 Echo (ping) request 1id=0x0036, seq=2/512, ttl=64 (reply in 6)
ipars 10.0.1.11 IcMp 98 Echo (ping) reply id=0x0036, seq=2/512, ttl=64 (request in 5)
ipcomp 10.0.1.12 IcMp 98 Echo (ping) request 1d=0x0036, seq=3/768, ttl=64 (reply in 8)
ipcp 10.0.1.11 IcMp 98 Echo (ping) reply id=0x0036, seq=3/768, ttl=64 (request in 7)
ipdc 10.0.1.12 ICMP 98 Echo in request 1d=0x0036, seq=4/1024, ttl=64 (reply in 10
ping q q ply
ipdr 10.0.1.11 IcMp 98 Echo (ping) reply id=0x0036, seq=4/1024, ttl=64 (request in 9)
iperf2 10.0.1.12 ICMP 98 Echo (ping) request 1id=0x0036, seq=5/1280, ttl=64 (reply in 12)
!Pfc 10.0.1.11 ICMP 98 Echo (ping) reply id=0x0036, seq=5/1280, ttl=64 (request in 11)
ipmb fe:7a:ab:37:e7:4b  ARP 42 Who has 10.0.1.11? Tell 10.0.1.12
‘b be:@b:8c:f7:58:e6  ARP 42 10.0.1.11 is at fe:7a:ab:37:e7:4b
Ipmi.trace
ipmi_session
ipnet
ipoib v
< >

Frame 3: 98 bytes on wire (784 bits), 98 bytes captured (784 bits) on interface ©

Ethernet II, Src: fe:7a:ab:37:e7:4b (fe:7a:ab:37:e7:4b), Dst: be:0b:8c:f7:58:e6 (be:0Ob:8c:f7:58:e6)
Internet Protocol Version 4, Src: 10.0.1.11, Dst: 10.0.1.12

Internet Control Message Protocol

O I Internet Protocol Version 4: Protocol Packets: 14 - Displayed: 14 (100.0%)

Profile: Default

ﬂ O Type here to search

Topology Summary = X
Node Console

» € Ethernethub-1 none

» € pPC-1 telnet 192.168.88.129:5000

» © pPC2 telnet 192.168.88.129:5002

» © pPC3 telnet 192.168.88.129:5004

» © pCc4 telnet 192.168.88.129:5006
Servers Summary = X

€) DESKTOP-65JUKD5 CPU 11.8%, RAM 56.4%
» €3 GNS3 VM (GNS3 VM (2)) CPU 0.3%, RAM 10.6%

& B

11:19 PM

7/21/2019
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+

é*— [Ethernethub-1 Ethernet0 to PC-1 eth0] - X
File  Edit View Go Capture Analyze  Statistics Telephony  Wireless Tools Help
OW-RC RE Qe EF == QaamE
ip.addr == 10.0.1.11| Expression...
No. Time Source Destination Protocol  Length Info
3 0.000337 10.0.1.11 10.0.1.12 ICMP 98 Echo (ping) request 1id=0x0036, seq=1/256, ttl=64 (reply in 4)
4 0.000450 10.0.1.12 10.0.1.11 ICMP 98 Echo (ping) reply id=0x0036, seq=1/256, ttl=64 (request in 3)
5 0.999130 10.0.1.11 10.0.1.12 IcMp 98 Echo (ping) request 1id=0x0036, seq=2/512, ttl=64 (reply in 6)
6 0.999663 10.0.1.12 10.0.1.11 IcMp 98 Echo (ping) reply id=0x0036, seq=2/512, ttl=64 (request in 5)
7 2.000815 10.0.1.11 10.0.1.12 ICMP 98 Echo (ping) request 1id=0x0036, seq=3/768, ttl=64 (reply in 8)
8 2.001124 10.0.1.12 10.0.1.11 IcMp 98 Echo (ping) reply id=0x0036, seq=3/768, ttl=64 (request in 7)
9 2.999778 10.0.1.11 10.0.1.12 IcMP 98 Echo (ping) request id-@x@@36, seq=4/1024, ttl=64 (reply in 10)
10 3.000341 10.0.1.12 10.0.1.11 IcMP 98 Echo (ping) reply  id-8x@@36, seq=4/1024, ttl=64 (request in 9)
11 4.001792 10.0.1.11 10.0.1.12 IcMP 98 Echo (ping) request id-@x@@36, seq=5/1280, ttl=64 (reply in 12)
12 4.002525 10.0.1.12 10.0.1.11 ICMP 98 Echo (ping) reply  id-8x@@36, seq-5/1280, ttl=64 (request in 11)
<

Frame 3: 98 bytes on wire (784 bits), 98 bytes captured (784 bits) on interface ©

Ethernet II, Src: fe:7a:ab:37:e7:4b (fe:7a:ab:37:e7:4b), Dst: be:0b:8c:f7:58:e6 (be:0Ob:8c:f7:58:e6)
Internet Protocol Version 4, Src: 10.0.1.11, Dst: 10.0.1.12

Internet Control Message Protocol

() 7 wireshark_-_20190721225643_a09792.pcapng

Packets: 14 - Displayed: 10 (71.4%)

Profile: Default
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é*— [Ethernethub-1 Ethernet0 to PC-1 eth0] - X

File  Edit View Go Capture Analyze  Statistics Telephony  Wireless Tools Help
mde RE QesEF S QQ QI

—-

ip.src == 10.0.1.11 Expression... +
No. Time Source Destination Protocol  Length Info
3 0.000337 10.0.1.11 10.0.1.12 ICMP 98 Echo (ping) request 1d=0x0036, seq=1/256, ttl=64 (reply in 4)
5 0.999130 10.0.1.11 10.0.1.12 ICMP 98 Echo (ping) request 1id=0x0036, seq=2/512, ttl=64 (reply in 6)
7 2.000815 10.0.1.11 10.0.1.12 ICMP 98 Echo (ping) request 1id=0x0036, seq=3/768, ttl=64 (reply in 8)
9 2.999778 10.0.1.11 10.0.1.12 ICMP 98 Echo (ping) request id-@x@@36, seq=4/1024, ttl=64 (reply in 10)
11 4.001792 10.0.1.11 10.0.1.12 ICMP 98 Echo (ping) request id=0x@036, seq=5/128@, ttl=64 (reply in 12)
< >

Frame 3: 98 bytes on wire (784 bits), 98 bytes captured (784 bits) on interface ©

Ethernet II, Src: fe:7a:ab:37:e7:4b (fe:7a:ab:37:e7:4b), Dst: be:0b:8c:f7:58:e6 (be:0Ob:8c:f7:58:e6)
Internet Protocol Version 4, Src: 10.0.1.11, Dst: 10.0.1.12

Internet Control Message Protocol

() 7 wireshark_-_20190721225643_a09792.pcapng Packets: 14 - Displayed: 5 (35.7%) Profile: Default
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AutoSave (¢ ) lab2_7-19.docx

ﬁ*— [Ethernethub-1 Ethernet0 to PC-1 eth0Q] - X & Share 1 Comments
File  Edit View Go Capture Analyze  Statistics Telephony  Wireless Tools Help /OFind v '
P — g Cel AaBbCcl
w4 e XCO Qe EF I S = QAQaQE ’ G'c Replace =
. hasis  Intense E... Dictate
. Apply a display filter ... <Ctrl-/> ¥ | Expression... =+ [} Select v o
No. Time Source Destination Protocol  Length Info . Editi .
Hl iting Voice ~
1 ©.000000 fe:7a:ab:37:e7:4b Broadcast ARP 42 Who has 10.0.1.12? Tell 10.0.1.11
2 0.000234 be:0@b:8c:f7:58:e6 fe:7a:ab:37:e7:4b ARP 42 10.0.1.12 is at be:0@b:8c:f7:58:e6
3 0.000337 10.0." "~ e ICMP 98 Echo (ping) request 1d=0x0036, seq=1/256, ttl=64 (reply in 4)
4 0.000450 oo | mmslmmErcFadi ICMP 98 Echo (ping) reply  id=0x@@36, seq=1/256, ttl=64 (request in 3)
5 0.999130 10.0. Ignore/Unignore Packet ICMP 98 Echo (ping) request id=0x0036, seq=2/512, ttl=64 (reply in 6)
6 0.999663 10.0. Set/Unset Time Reference ICMP 98 Echo (ping) reply id=0x0036, seq=2/512, ttl=64 (request in 5)
7 2.000815 10.0. Time Shift... ICMP 98 Echo (ping) request 1id=0x0036, seq=3/768, ttl=64 (reply in 8)
8 2.001124 10.0. s e IcMp 98 Echo (ping) reply id=0x0036, seq=3/768, ttl=64 (request in 7)
9 2.999778 10.0. ICMP 98 Echo (ping) request id=0x@036, seq=4/1024, ttl=64 (reply in 10)
10 3.000341 10.0. Bl Resslved Name IcMp 98 Echo (ping) reply id=0x0036, seq=4/1024, ttl=64 (request in 9)
11 4.001792 10.0. ICMP 98 Echo (ping) request 1id=0x0036, seq=5/1280, ttl=64 (reply in 12)
12 4.002525 19.0.__ Echo (ping) reply  id=0x0@36, seq=5/1280, ttl=64 (request in 11)
13 5.007679 bess 3 Not Selected Who has 10.0.1.11? Tell 10.0.1.12
14 5.008505 fe:7a . . 10.0.1.11 is at fe:7a:ab:37:e7:4b
Conversation Filter 4 ...and Selected
Colorize Conversation 4 ...or Selected
SCTP 4 ...and not Selected
Follow 4 ...or not Selected
< Copy 4 >
Frame 3: 98 bytes on wire (784 bits) on interface ©
Protocol Preferences ’
Ethernet II, Src: fe:7a:at , Dst: be:0b:8c:f7:58:e6 (be:0Ob:8c:f7:58:e6)
Internet Protocol Version DEERLE 5 1.12
Internet Control Message F Show Packet in New Window
() 7 wireshark_-_20190721225643_a09792.pcapng Packets: 14 - Displayed: 14 (100.0%) Profile: Default

4 PART 7. Arp-Spoofing Attack
Exercise 7. Corrupt the ARP table on designated...
Lab Questions o

Appendix: Wireshark Filters

Page 18 of 18 3136 words [ |% Focus EE B B - ] + 100%

: 11:41 PM
ﬂ O Type here to search : 7/21/2019
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ﬁ*— [PC-1 ethO0 to Ethernethub-1 Ethernet0] - X

File  Edit View Go Capture Analyze  Statistics Telephony  Wireless Tools Help

-G N/ Qe EF S QQQ F
. eth.src == 6a:23:93:17:58:f1 Expression... 4= No cisco
No. Time Source Destination Protocol  Length Info
1 ©.000000 6a:23:93:17:58:f1 Broadcast ARP 42 Who has 10.0.1.12? Tell 10.0.1.11
3 0.000150 10.0.1.11 10.0.1.12 ICMP 98 Echo (ping) request 1id=0x003b, seq=1/256, ttl=64 (reply in 4)
5 0.999752 10.0.1.11 10.0.1.12 IcMp 98 Echo (ping) request 1id=0x003b, seq=2/512, ttl=64 (reply in 6)
7 2.001519 10.0.1.11 10.0.1.12 ICMP 98 Echo (ping) request 1id=0x003b, seq=3/768, ttl=64 (reply in 8)
9 3.002123 10.0.1.11 10.0.1.12 IcMp 98 Echo (ping) request 1id=0x003b, seq=4/1024, ttl=64 (reply in 10)
11 4.005939 10.0.1.11 10.0.1.12 ICMP 98 Echo (ping) request id=0x@@3b, seq=5/128@, ttl=64 (reply in 12)
14 5.015216 6a:23:93:17:58:f1 Oe:af:3b:50:€6:88 ARP 42 10.0.1.11 is at 6a:23:93:17:58:f1
< >

Frame 1: 42 bytes on wire (336 bits), 42 bytes captured (336 bits) on interface ©
Ethernet II, Src: 6a:23:93:17:58:f1 (6a:23:93:17:58:f1), Dst: Broadcast (ff:ff:ff:ff:ff:ff)
Address Resolution Protocol (request)

ff ff ff ff £ff ff 6a 23 93 17 58 f1 08 06 00 01 j# - -X )
08 00 06 04 00 01 6a 23 93 17 58 f1 @a 00 01 @b j# - -X

() 7 wireshark_-_20190807135952_a09052.pcapng Packets: 14 - Displayed: 7 (50.0%) Profile: Default
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ﬂ*— [Ethernethub-1 Ethernet0 to PC-1 ethQ]

File  Edit View Go

- X
Capture  Analyze  Statistics  Telephony  Wireless Tools  Help

AN 0 RO JIeEDEFEI[EQAQAQE
A

- | Expression... +
No. Time Source Destination Protocol  Length Info
1 0.000000 fe:7a:ab:37:e7:4b Broadcast ARP 42 Who has 10.0.1.12? Tell 10.0.1.11
14 5.008505 fe:7a:ab:37:e7:4b

be:@b:8c:f7:58:e6 ARP 42 10.0.1.11 is at fe:7a:ab:37:e7:4b

<

>
> Frame 1: 42 bytes on wire (336 bits), 42 bytes captured (336 bits) on interface ©

> Ethernet II, Src: fe:7a:ab:37:e7:4b (fe:7a:ab:37:e7:4b), Dst: Broadcast (ff:ff:ff:ff:ff:ff)
> Address Resolution Protocol (request)

(O 7 wireshark_-_20190721225643_a09792.pcapng

|| Packets: 14 - Displayed: 2 (14.3%)

| | Profile: Default
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é*— [Ethernethub-1 Ethernet0 to PC-1 eth0] - X

File  Edit View Go Capture Analyze  Statistics Telephony  Wireless Tools Help
m4e RC| QesEFS Q Qi

—-

lip.src == 10.0.1.11 Expression... +
No. Time Source Destination Protocol  Length Info
1 0.000000 fe:7a:ab:37:e7:4b Broadcast ARP 42 Who has 10.0.1.12? Tell 10.0.1.11
2 0.000234 be:@b:8c:f7:58:e6 fe:7a:ab:37:e7:4b ARP 42 10.0.1.12 is at be:0b:8c:f7:58:e6
4 0.000450 10.0.1.12 10.0.1.11 ICMP 98 Echo (ping) reply id=0x0036, seq=1/256, ttl=64 (request in 3)
6 0.999663 10.0.1.12 10.0.1.11 IcMp 98 Echo (ping) reply id=0x0036, seq=2/512, ttl=64 (request in 5)
8 2.001124 10.0.1.12 10.0.1.11 IcMp 98 Echo (ping) reply id=0x0036, seq=3/768, ttl=64 (request in 7)
10 3.000341 10.0.1.12 10.0.1.11 ICMP 98 Echo (ping) reply id=0x0036, seq=4/1024, ttl=64 (request in 9)
12 4.002525 10.0.1.12 10.0.1.11 ICMP 98 Echo (ping) reply 1d=0x0036, seq=5/1280, ttl=64 (request in 11)
13 5.007679 be:@b:8c:f7:58:e6 fe:7a:ab:37:e7:4b ARP 42 Who has 10.0.1.11? Tell 10.0.1.12
14 5.008505 fe:7a:ab:37:e7:4b be:@b:8c:f7:58:e6 ARP 42 10.0.1.11 is at fe:7a:ab:37:e7:4b
< >

Frame 2: 42 bytes on wire (336 bits), 42 bytes captured (336 bits) on interface ©
Ethernet II, Src: be:@b:8c:f7:58:e6 (be:0Ob:8c:f7:58:e6), Dst: fe:7a:ab:37:e7:4b (fe:7a:ab:37:e7:4b)
Address Resolution Protocol (reply)

() 7 wireshark_-_20190721225643_a09792.pcapng Packets: 14 - Displayed: 9 (64.3%) Profile: Default
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£ Capturing from - [PC1 eth0 to Ethemethub-1 Eshernetd] - a x
Hle Edt Vew Go Gopure Andyze Surstcs Telphony Wircless Took  Help

LR RG AesEFEZEQaqQE
oo gl <o o=
o e Destiration Protocsl Langin_ I
1 0.000000 Broadcast arp 42 Who has 10.0.1.127 Tell 10.0.1.11
2 0.000007 eailciliiodiionde  ARP 42 10.8.1.12 15 at d2:dfise
3e.epe725 10.6.1.11 10.0.1.12 amp 9 Echo (ping) request 4 (reply in 4)
so.om790  10.6.1.12 10.0.1.11 1o 98 Echo (ping) reply /256, ti1=64 (request in 3)
5 leels  10.6.1.11 19.0.1.12 T 98 Echo (ping) request seg-2/512, tE1-64 (raply in 6)
5 leewss  10.6.1.12 10.0.1.11 amp 98 Echo (ping) reply /512, ttl-64 (request in 5)
7200100 10.0.1.11 10.0.1.12 T 98 Echo (ping) request /768, tt1-60 (reply 1n #)
52001202 10.0.1.12 19.0.1.11 T 98 Echo (ping) reply 4 (request in 7)
93000708 10.6.1.11 10.0.1.12 cnp 98 Echo (ping) request /1024, tt1=64 (reply in 16)
10 3.060850  10.8.1.12 10.0.1.11 Tanp 98 Echo (ping) reply Sag-4/1624, te1-61 (request in 9)
114000502 10.8.1.11 10.0.1.12 amp 95 Echo (ping) request /1280, ttl=64 (reply in 12)
1240000 10.0.112 10.0.2.11 1o 98 cho (ping) reply /1280, tt1-64 (request in 1)
135.017307  da:dfibercdihdi6f  carcil3idioide  ARP 42 Who has 10.0.1.112 Tell 10.6.1.12
14 5.018937 13:9d:39:d0  d2:dFibercdib3int  ARP 4210.8.1.11 i at ea:3c:13:9d

Frame 1: 42 bytes on wire (336 bits), 42 bytes captured (336 bits) on interface o
Ethernet 11, Sre 8 (ea:3ci13:94:39:da), Dst: Broadcast (- FFFFFFLF)
Address Resolution Protocol (request)

a0 £F I (€ £ (7 (f ea 3c 13 9d 39 do @8 06 00 01 <
G010 BB 80 06 4 6@ 61 ea 3¢ 13 9d 39 do 82 6@ @1 eb <
20 80 09 60 90 00 00 04 00 1 BC

T ey [[ pacets: 14 vt 14 1000%)
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M Capturing from - [PC1 eth to Ethernethub-1 Ethemet0] o x

Fle Edt Vi Go Capture Anale  Statistics Telephony  Wirsless Tooks  Help

mJde RE QemES $ AR QF
W ori = cirpoy e <G /> <) Exresion.. | +
Fier Bttons prfernces.. Labelrise  dscrpion for e e buton Fer:_Coter  fiter expresson o e ppied
oc Gl
Comment: [Erer a commen or e ier o
o e Source Destntion broocol _Lengh i ~
10.000000  ea:dc:13:9d:39:d0  Broadeast a8p 42 Who has 10.0.1.127 Tell 10.0.1.11
20.00007  d2idficercd:biiof  eaici13:iodioide  ARP 42 10.0.1.12 15 at d2:0F:ceicdihdioF
30000725  10.0.1.11 10.8.1.12 o 96 Echo (ping) request id-9x0822, seq-1/256, ttl-64 (reply in 4)
4e.ome795  10.0.1.12 10.0.1.11 cm 95 Echo (ping) reply  id-8x0e22, seqe1/256, ttl=6d (request in 3)
5 leeei  10..1.11 10.0.1.12 e 98 Echo (ping) request 1d-8xe622, seq-2/512, tt1-64 (reply in 6)
6 leew7ss  10.0.1.12 10.0.1.11 e 98 Echo (ping) reply  id-0x022, seq=2/512, ttl-64 (request in 5)
7 2.00004  10.6.1.11 10.0.1.22 o 98 Echo (ping) request id=0x0622, seq=3/768, LL1=64 (reply in 8)
82001202 10.0.1.12 10.0.1.11 e 98 Echo (ping) reply  1d-8x0822, seq-3/768, ttl-64 (request in 7)
o .0m0708  10.0.1.11 10.0.1.12 T 98 Echo (ping) request id=0x0822, seq=4/1024, ttl-6d (reply in 10)
10 s.000850  10.0.1.12 10.0.1.21 1cnp 95 Echo (ping) reply  10-0x0622, seq=4/1024, Lt1=64 (request in 9)
114000502 10.0.1.11 10.0.1.12 o 96 Echo (ping) request id-x0822, seq-5/1288, ttl-64 (reply in 12)
12400010 10.0.112 10.0.1.11 am 98 Echo (ping) reply  id=0x0822, seq=5/1280, ttl=6d (request in 11)
135.017397  d2idfibeicd:ibii6f  earicil3iodiiide  ARP 42 Who has 10.6.1.112 Tell 10.6.1.12 9
< >
Frame 1: 42 bytes on uire (336 bits), 42 bytes captured (3% bits) on interface 6
Ethernet TI, Src: ea:ic:13:9d:39:d0 (ea 9d:39:d8), Dst: Droadcast (FFifFifFifFifFier)
Address Resolution Protocol (request)
Gac FE F6 F6 FF FF FF ca 3c 139 39 do €8 @6 00 o1 <oe
G010 68 60 66 64 60 01 ea 3 13 90 39 dB ea @B €L éb <o

920 8 99 B0 00 B0 60 B2 60 1 Oc

7' Ready to lond or capture Packets: 14 * Displayed: 14 (100.0%) Profle; Default
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Fiter Buttons Preferences... | Label: |pCi] Fiter: [paddr==10041t |

[l

Comment: |Enter a comment for the filter button
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M Capturing from - [PC1 eth0 to Ethernethub-1 Ethemet0] - o x

Fle Edit View Go Capture Amalze Swtistis Telephony Wireless Iools Help

) R Reszs = Eaaaf
ol s gl er <o <) eoresen.. [ +_rct
Time Destihatan Protocol Length I
1 0.000000 Broadcast AP 42 Who has 10.0.1.127 Tell 10.0.1.11
2 0.000057 agp 4210.0.1.12 is at d2:df:6e:cd:b3iof
3 0.000725 Tcn 98 Echo (ping) request i 5aq-1/256, tt1-64 (reply in 1)
4 0.00079 b 98 Echo (ping) reply seq=1/256, LL1=64 (request In 3)
5 1.001638 Tanp 98 Fcho (ping) request seq-2/512, tt1=64 (reply in 6)
6 1.001783 an 98 £cho (plng) reply  1d=8x0022, seq=2/512, Ttl=64 (request in 5)
7 2.00109 pr 98 Echo (ping) request id-0x0022, seq=3/768, ttl=s4 (reply in 8)
8 2.00120 cnp 98 Echo (ping) reply 50q-3/768, tt1-64 (request in 7)
9 3.000708 awe 98 Echo (ping) request seq=3/1024, Lt1=64 (reply in 10)
10 3.000850 Tcnp 98 Echo (ping) reply 5aq-4/1024, t£1-64 (request in 9)
11 4.000502 an 98 Echo (ping) request id-0x0022, seq=5/1280, ttl=64 (reply In 12)
12 1.001010 Tanp 98 Fcho (ping) reply  1d-8x@022, saq-5/1280, ttl-64 (request in 11)
13 5.017397 P 42 Who has 10.9.1.117 Tell 10.0.1.12
14 5.018937 P 42 10.0.1.11 is at ea:3c:13:9d:39:do
< >

Frame 1: 42 bytes on wire (336 bits), 42 bytes captured (336 bits) on interface o

Ethernet TT, Src: ea 39:d8 (ea:3ci13 @), Dst: Broadcast (£:FFiff

Address Resolution Protocol (request)

G R FE R FEHF 3 3¢ 13750 36 d0 08 06 60 01 L)

6010 08 e 0o 04 0o o1 EIETNEERTIETIT) ea 00 o1 00 =]
2520 60 60 60 00 00 00 0a €0 01 O

e — || ockes: 14 Dispoyed: 14 (100.0%)
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‘*— [PC1 ethO to Ethernethub-1 Ethernet0] - X

File  Edit View Go Capture Analyze  Statistics Telephony  Wireless Tools Help

AW 0 P OARO IesEF S Qe
ip.addr == 10.0.1.11| Expression... = PC1
No. Time Source Destination Protocol  Length Info
3 0.000725 10.0.1.11 10.0.1.12 ICMP 98 Echo (ping) request 1d=0x0022, seq=1/256, ttl=64 (reply in 4)
4 0.000796 10.0.1.12 10.0.1.11 IcMp 98 Echo (ping) reply id=0x0022, seq=1/256, ttl=64 (request in 3)
5 1.001638 10.0.1.11 10.0.1.12 IcMp 98 Echo (ping) request 1id=0x0022, seq=2/512, ttl=64 (reply in 6)
6 1.001783 10.0.1.12 10.0.1.11 IcMp 98 Echo (ping) reply id=0x0022, seq=2/512, ttl=64 (request in 5)
7 2.001094 10.0.1.11 10.0.1.12 IcMp 98 Echo (ping) request 1d=0x0022, seq=3/768, ttl=64 (reply in 8)
8 2.001292 10.0.1.12 10.0.1.11 IcMp 98 Echo (ping) reply id=0x0022, seq=3/768, ttl=64 (request in 7)
9 3.000708 10.0.1.11 10.0.1.12 ICMP 98 Echo (ping) request id-@x@@22, seq=4/1024, ttl=64 (reply in 10)
10 3.000850 10.0.1.12 10.0.1.11 ICMP 98 Echo (ping) reply  id-8x@@22, seq=4/1024, ttl=64 (request in 9)
11 4.000502 10.0.1.11 10.0.1.12 ICMP 98 Echo (ping) request id-8x@@22, seq=5/1280, ttl=64 (reply in 12)
12 4.001010 10.0.1.12 10.0.1.11 ICMP 98 Echo (ping) reply  id=0x@@22, seq=5/1288, ttl=64 (request in 11)
< >

Frame 3: 98 bytes on wire (784 bits), 98 bytes captured (784 bits) on interface ©

Ethernet II, Src: ea:3c:13:9d:39:d0 (ea:3c:13:9d:39:d0), Dst: d2:df:6e:cd:b3:6f (d2:df:6e:cd:b3:6f)
Internet Protocol Version 4, Src: 10.0.1.11, Dst: 10.0.1.12

Internet Control Message Protocol

61 04 40 00 40 8e Qa 00 01 ©b 0a 00 Ta-@-@

08 00 4f e8 00 01 72 48 3e 5d 00 00 o--" rH>]

32 7c 06 00 00 00 10 11 12 13 14 15 2|

18 19 1a 1b 1c 1f 20 21 22 23 24 25 1" #$%

28 29 2a 2b 2c 2f 30 31 32 33 34 35 &'()*+,- ./012345
67

() 7 wireshark_-_20190728181427_a18480.pcapng Packets: 14 - Displayed: 10 (71.4%) - Dropped: 0 (0.0%) || Profile: Default





